
Preface 

 

The language is the most important intellectual instrument of an individual as well as of a nation. Only the language 
can help us to understand each other, express our thoughts, convey or accumulate information about the world and 
about ourselves. The language is the basis of the manufacturing as well - after the confusion of tongues the Tower 
of Babel was never completed. Now it is universally agreed that a language is an exceptional value of any nation 
which must be carefully fostered. However, it is not a frozen value - the language is constantly changing, it is 
adapting to new phenomena in the world. Five years have passed since the first edition of the ANGLONAS 
dictionary. During this period the sphere of usage of Lithuanian widened rapidly, Lithuanian acquired an 
international status. The development of Lithuanian terminology has accelerated, the Lithuanian computer 
linguistics has evolved rapidly over this period.  In one way or another these positive changes are reflected  in the 
second version of the ANGLONAS dictionary presented here.  

The content of the dictionary has been considerably expanded. The main dictionary contains more than 118 000 
different English words and phrases translated to Lithuanian. In comparison with 2005 edition the dictionary is 
significantly expanded with the words of the standard language, as well as with computer, medical, military and 
other terms. A number of minor errors and inaccuracies found in B. Piesarskas dictionary have been corrected. The 
WordWeb based English thesaurus with more than 158 000 headwords is also included in the ANGLONAS 2 
dictionary. A new software has been developed to display the semantic information of the thesaurus more 
conveniently. The thesaurus is seamlessly integrated into a common search system of the ANGLONAS 2 dictionary 
database, therefore the user will find more than 223 000 different English words and phrases translated to 
Lithuanian or their English definitions there.  

The appearance and functionality of the ANGLONAS 2 dictionary is completely new. The structure and controls of 
the main window of the program comply with the guidelines of the Microsoft® Office Fluent™ user interface. A user 
can easily change the look and functionality of the program. It is possible to build user dictionaries easily in this 
version of the program. A user dictionary is also seamlessly integrated into the common search system, therefore 
the user will be able to see his newly introduced headwords alongside with the headwords of the main dictionary 
and English thesaurus. That opens a new vista on expanding the dictionary database with words drawn from 
various realms of life, coined phrases or missing meanings for words. Also, the user can easily import dictionaries 
of other authors and merge them with his own dictionaries. All user dictionaries are saved to separate files.  

The most profound changes have been made in the search system of the dictionary. The search is equally effective 
in both directions of translation. Now a query word (i. e. the word you enter in the search field) can be found not 
only in the list of dictionary headwords, but in separate phrases inside dictionary articles as well.  Also, the similarly 
sounding words or context of usage can be found. The context of usage is constructed from the dictionary phrases 
containing the query word. The context is shown in the form of concordance, which is common in the computer 
linguistics but is rather innovative in dictionaries. In this mode the column of query words constitute the axis around 
which the phrases are arranged. This vivid presentation helps a great deal in grasping the correct usage of a 
particular word. The improved search system enables to find more than 145 000 Lithuanian words and phrases 
translated to English. Almost any grammatical form of the Lithuanian word can be entered into the search field, and 
it will be translated correctly.  

The dictionary uses a modern single click translation (VVV - Lithuanian abbreviation) technology in order to 
minimize the user actions necessary to get the translation of a particular word. In Windows XP/Vista/7 all you need 
to get the translation of a word of interest is hover the mouse cursor over that word for more than 3 seconds. After 
that you will get the translation in a separate window. The program automatically detects the language of the word 
to be translated, also, it performs the analysis of the neighbouring words, therefore the most probable translations 
are presented on the top of the list of translations. The program recognizes not only the headwords, but the 
inflected forms as well. Also, you can get the same result in a traditional way - by moving the mouse cursor over 
any word of interest and then clicking it with the predefined mouse button while pressing and holding the 
designated keyboard key. After clicking you will get the translation in a separate window. In the same window you 
can translate the clicked sentence or the paragraph using the on-line machine translation service of the Vytautas 
Magnus University - provided you download a necessary plug-in from their website. 

 



 

Presentation of translations 

The translations can be presented in two ways in this program: in the main window and in a single click translation 
window. 

 

The amount and content of information presented in the main window depends on direction of translation and the 
method of search (five methods of search are available). The list of translation findings is presented in the Findings 
pane, and the form of the list depends on the search method used. The dictionary article containing the translation 
is presented in the Article pane of the main window, full dictionary information is given there. Word usage 
frequency is also indicated there. 

The compact single click translation window presents the translation of the word, which is under the mouse cursor. 
One of the most convenient ways to obtain the translation of a word on a computer screen is to move the mouse 
cursor onto that word and click it, while simultaneously holding  a specially assigned key on a keyboard. This action 
(the default combination is CTRL + Right click of a mouse) invokes a separate single click translation window 
(called here the VVV window) containing the translation of the word clicked on. There is no need to type a word in 
order to get the translation of it. Moreover, in this case the program analyzes the context (the surrounding words) of 
a word being translated, and automatically selects the most appropriate translations to be shown in the VVV 
window. The VVV window can close automatically or stay visible indefinitely - you can choose any mode after 
pressing the Program's settings button in the VVV window. 

 

Getting translations in the main window  

The sequence of the necessary actions that must be performed to get the translation in the main window can 
slightly differ from those given in the present description.  

 



1. The launched program opens the main window where the Home tab (here marked by 1 superimposed on a 
red circle, see the picture above) is selected. The program is ready for the search of translations. If the launched 
window has a minimized ribbon you may click on the Home tab to display its commands (controls).  

2. The buttons of the Direction group (marked by 2 in the picture above) of the Home tab defines the direction 
of translation. The selected button indicates the direction of translation (i. e. it shows the source language - the 
language from which the translation is done). If you press on a button once, it remains selected (the selected status 
is indicated by discernible colour) until the direction of translation is changed by pressing the another button of this 
group. If the Ribbon is minimized (the main window is in a compact mode), you can change the direction of 
translation by pressing the direction buttons on a Quick Access toolbar (if the buttons are present there), or simply 
by pressing on the Home tab and afterwards on the button of an appropriate direction.  

3. Into the Search field (marked by 3 in the picture above) you must enter  a word or phrase that will be used 
by the search engine (called respectively the query word and query phrase throughout this documentation) to find 
relevant entries in the dictionaries of this program. If the current mode of search suits you (it is denoted by the 
selected button in the Search group), you can press the ENTER key on the keyboard or simply wait a moment or 
two (the delay can be changed in the Program's settings window, in the Search theme), the search will start 
automatically. If the current mode of search does not suit you, see the description below. The text can be entered 
by typing on a computer or on-screen keyboard, or can be automatically taken from the clipboard or by other 
methods.  
In the Search field you must enter the query word or the query phrase (the word or phrase you want to be 

translated). If the button Use search prompter is switched on during the text entry, then a list of candidate 
headwords which are present in the dictionary is prompted in the List pane (marked by 5 in the picture above). If 
you see the necessary word or phrase in the prompted list, choose it using the mouse or use the up and down 
arrows keys of the keyboard. Subject to the settings of the program, the dictionary article is shown in the Article 
pane marked by 6 in the picture above) after some predefined time or after pressing the ENTER key on the 
keyboard. It is the fastest search method in the main window.    
 
If the button Use search prompter is switched off, you must select the mode of search from the Search command 
group. If the current mode of search (the marking of current selection is done by changing the background of a 
button in the group) suits you, simply press ENTER after entering the query or the search will start automatically 
after some time (the start mode is defined in the settings). If the current mode of search does not suit you can 
choose the appropriate search mode, below will be explained how to choose it.  
Note. The text can be entered using the computer keyboard or the on-screen keyboard, getting it automatically 
from the clipboard, choosing from the menu list or by other means. The delay of the search can be changed in the 
Settings window, Search theme.   

4. The Search group (marked by 4 in the picture above) contains the buttons which activate various search 
modes. After pressing the upper part of the Words button or the Context button it remains selected, therefore it is 
not necessary to define anew the mode for each search, it remains the same until you will redefine it by pressing 
an appropriate button. This stability is convenient, because most searches will start automatically with some time 
delay after the last character was entered into the Search field or searches will start after pressing the ENTER key 
on the keyboard, and not by pressing one of the search buttons. By pressing the dropdown arrow of the Words split 
button you will invoke a menu where you can get the more specific search modes: the search of headwords in all 
dictionaries (launched by the Headwords button), the search of words with the same first letters (launched by the 
Prefix button) and the search of similarly sounding words (launched by the Similarity button). These specific modes 
of search cannot be selected, they should be invoked for each instance of search.  

5. The search procedure generates the list of findings, which are shown on the List pane, in the Findings tab. 
The content and form of the list of findings depends on the search mode used. The best finding is selected in the 
list (in the picture above see the line in deep blue, in the Findings tab). The pictographs on the right side of the line 
denote which dictionaries of this program contain the articles with relevant information. Note the different tabs in 
the List pane. By pressing on the My words tab you will get a list of headwords of the user dictionary – the 
dictionary that you created yourself. By pressing on the History tab you will get a list of dictionary articles you have 
been viewing in the past. Clicking the list item in the List pane with the mouse will select it and will present the 
corresponding dictionary article in the Article pane.  

6. The dictionary articles are shown in the Article pane. The brighter tab in this pane indicates the 
dependency of the article shown in this pane to a particular dictionary, denoted by that tab. By pressing another tab 
in this pane you will get the corresponding article from another dictionary (if only the article was found in this 
dictionary by the search engine). The tabs can be on the top or bottom of the pane, you can define their position in 
the settings of the program.  

 



Translation in the VVV (Single click translation) window  

Two methods of picking up information can be used to get translations in the VVV window.  

1. Automatic translation occurs if the mouse cursor is positioned over any word and rests there unmoved for more 

than 3 seconds. This method of translation is enabled if the button inside the single click translation (VVV) 
window is switched on. Using this method you can get translations of words in situations when the text of interest 
usually disappears after any key-press.  

2. Translating the text under the mouse cursor  

 

a)    Move the mouse cursor over the word to be translated.  

Even texts in pictures can sometimes be translated by this method, you should mark the Use OCR check box in the 
Text recognition group of the Other settings theme in the Program's settings window. Sometimes the screen 
reading can be blocked by some programs - then use the clipboard to pick up information. Even the copying to the 
clipboard is not allowed by some programs - in this case select the text and press the key combination Ctrl+Shift+T 
on the keyboard (you should mark the Translate the selected text check box, in the Start of translation group of the 
Single click translation theme in the Program's settings window) or simply enter the text from the keyboard in the 
main window to get the translation.  

b)    Press simultaneously the chosen combination of keys, the default combination is CTRL + Right click of a 
mouse. A more appropriate combination could be chosen in the Single click translation theme, in the Program's 
settings window.  

c)    A separate window (VVV) pops up, it contains the translation.  

Note. The form and amount of the translated material depends on the settings chosen from the drop-down menu 
on the right of the VVV window, it also depends on additional settings invoked by the right click of a mouse, 
positioned in the VVV window area, used to display the translations (the text area of the VVV window).  

d)    If the current direction of translation is not suitable, you can choose another direction by clicking the triangular 
arrow on the upper left corner of the VVV window.  

The VVV window can close automatically or stay visible indefinitely - you can choose any mode after pressing the 
Program's settings button on the right side of the VVV window.  

3. Translating the clipboard  



 

a)   To activate the translation of the clipboard, click the Main settings theme  in the Program's settings window.  

b)    Mark the appropriate check-boxes - Translate the clipboard and/or Translate the clipboard in the single click 
translation window.  

c)    If any of these check-boxes are marked, you will get the translation automatically after copying a text to the 
clipboard.  

Note. In some situations there is no possibility to copy a text to the clipboard, then you must manually enter the text 
in the main window in order to translate it.  

4. Translation after typing 

Some programs do not allow to copy the text to the clipboard or get it otherwise. In such cases you can open the 

text entry field by pressing the button. Please type the word(s) of interest into the entry field and press the 
ENTER key on your keyboard to get the translation. 

 

In the Virtual Keyboard field written word also can be directed translation in VVV window.  



 

 This is done by the button   or key combination Shift+Enter 

 
 

The main window 

At the start of the program the window with a progress bar is displayed. The translation of an occasional word is 
also shown there, for curious ones. 

 

Finally, the main window is opened, which is compliant with the Microsoft® Office Fluent™ user interface design 
guidelines. A user can easily change the look and functionality of the program. 

Several zones could be distinguished in a typical window (the zones are marked by encircled 
numbers in the picture below):  

1111  The application button  

2222  The quick access toolbar  

3333  Sizing buttons 

4444  The tab bar 

5555  Groups on the Ribbon 

6666  The search field  

7777  The list pane 

8888  The article pane 

9999  The status bar 

 



 

 

The arrangement of these zones, their appearance and skin can be changed. The variety of possible changes is 
very great, and pictures in the description of the program may differ from what you see on your computer screen.  
E. g., a particular set of settings can change the appearance of the main window to the following:  

 

 



The Application button  

Clicking the Application button displays the application menu, containing controls for performing actions on files 
and printing of dictionary articles.  

 

The button New  creates a new user dictionary file, which is empty, but can be filled later.  

You can choose any available user dictionary after pressing the Open  split button.  

 

Pressing on the left segment of the split button invokes the window where you can  select a user dictionary. After 
selecting a desirable user dictionary, you can make it active (i. e. viewable, editable and seamlessly attached to the 
search engine) by pressing the Open button on this invoked window. Sometimes a more easy way to make a user 

dictionary active is to press the right side of the Open  split button (the arrow), then use the most suitable 
menu item - Select, Last used or Default. By pressing the Select menu item you will invoke the same window as if 



pressing the left segment of the Open  split button. By pressing the Last used menu item you will activate the 
user dictionary that had been used before the default user dictionary was made active. By pressing the Default 
menu item you will activate the default user dictionary, which is supplied by the software vendor along with the 
main dictionary. The Default dictionary can be edited, however, you can not delete it.  

By pressing the Select button it is possible to choose and open any available user dictionary.  

Pressing the Default button opens the Default user dictionary.  

Pressing the Last used button opens again the user dictionary which had been active before the default 
dictionary was opened.  

Pressing the Import  button starts the import from another dictionary, the new records are added to the active 
user dictionary.  

By pressing the Save as button you can save the active user dictionary after specifying a new file name and 
location where you want to save the dictionary.  

Pressing the right segment of the Print  split button displays a menu with several options:  

 

Pressing the Print button starts an immediate printing of a dictionary article.  

Pressing the Print preferences opens a window with printing options.  

By pressing the Print preview button you can preview the document before it will be printed.  

Pressing the History  button displays a menu with two options:  



 

The Load history button opens a separate window where you can find and choose a previously saved history file.  

The Save button  opens a separate window where you can save your current history data, there you must indicate 
the history file name and its location.  

There are two buttons on the bottom bar:  

The Settings button opens a window with the program's settings.  

The Exit Anglonas  button closes the program.  

 
 



The Quick Access toolbar 

 

It is a toolbar, where at will you can assemble the most frequently used command buttons (controls). Usually this 
toolbar is displayed near the Application button, but you can move it down - directly above the Search field. By 
pressing on the dropdown arrow on the right side of the toolbar you can display a menu, which contains a list of 
candidate commands that can be included in the Quick Access toolbar. 

 

The checked commands are included in the Quick Access toolbar. If you uncheck a command, it will be removed 
from the Quick Access toolbar. 

 
 

The sizing buttons 

 

The tile bar of the main window contains 3 sizing buttons, at the top right corner. The Minimize button (leftmost on 
the picture) is used to reduce the size of the window to a button on the taskbar. The Maximize (central) button 
enlarges the window to fill the entire desktop. The Close button (rightmost) is used to close the window. 

 



The Tab bar 

 

Tabs are used to organize controls in the Ribbon (The Ribbon contains the following three elements: tabs, groups 
and controls). The tabs are placed  on a bar below the Application button. The tabs are always shown at fixed 
positions on the upper part of the window. Clicking on a tab selects that tab and the controls for that tab are 
displayed on the Ribbon (the tab is opened, it is active). The selected tab stands out against the background by its 
colour. Also, you can select a tab by pressing the ALT or F10 key on the keyboard. Afterwards the key tips will 
appear on the tabs, then press the key associated with the desired tab (the key tip on the tab suggests which key 
must be pressed on the keyboard to select that tab). The tab becomes selected, the keyboard focus moves to that 
tab, and the key tips for every command (control) on that tab become displayed. By pressing a key associated with 
the desired command you will invoke that command. 
There are four tabs in this program: Home, Editing, View and Help. 

 

Tabs and their controls 

The tabs are used to organize the commands (controls) in the Ribbon according to translation activities that users 
perform. Within each tab various related commands or options are also logically grouped together correlating with 
expected user activities performed using the dictionary. This two-tiered grouping greatly facilitates navigating the 
program. 

Clicking on a tab spreads out its commands. There are four tabs in this application: 

the Home tab includes the commands (controls) most frequently used to control the process of translation; 

the Editing tab includes the commands used to create and edit the user dictionaries as well as manage the history 
lists; 

the View tab includes the commands for changing the appearance of the application window; 

the Help tab includes the auxiliary commands. 

If the Compact command is executed (the command is easily found on the status bar, at the bottom of the window), 
the Ribbon becomes minimized (hidden), the commands (controls) spread out only after clicking with a mouse 
pointer on a proper tab. The spread out command groups are visible only until a command is selected or a mouse 
is clicked anywhere in the application window. 

 

The commands of the Home tab 

The Home tab contains four groups of commands (controls): Direction, Search, Services and Repetition.  

 

  You can choose the source language (the language you are translating from)  in the Direction group. The direction 
button indicates the source language by a brighter background.  

You will be translating from English (your source language will be English) if you will press the From English  
button.  

Your source language will be Lithuanian if you will press the From Lithuanian button.  



The Search group contains the command buttons for various search modes, you can choose an optimal mode 
there. By pressing a button in this group you will start searching for the translation (or an  explanation) of a word or 
phrase that is entered in the Search field (the word or phrase entered in the Search field is called the query word or 
query phrase throughout this documentation). There are the following modes of search in this group:  

By pressing on the upper part of the Words    split button you will start the smart search mode, which is the 
most versatile one for searching the translation of a single word or phrase. By pressing the dropdown arrow on this 
button you invoke a menu where you can get the more specific search modes.  

The action of the menu button Words is identical to that of the upper part of the Words split button.  

The menu button Headwords     starts the search for the presence of the query word in the headwords of all 
dictionaries, that are currently active in this program (main dictionary, active user dictionary and thesaurus). If you 
entered a phrase in the Search field, the exact phrase will be searched for in the headwords, additionally, the first 
word of the phrase will be searched for (in the headwords).  

The menu button Prefix  starts the search for all words matching the first letters of the query word, the search 
is performed in all dictionaries.  

The menu button Similarity   starts the search for all words sounding similarly to the query word, the search is 
performed in all dictionaries.  

The Context  button starts the search for phrases and examples containing the query word, the search is 
performed in all dictionaries inside dictionary articles. The results of this search are presented in the form of 
concordance, they represent the context of the word usage in the dictionaries of this program. The context helps to 
better understand various meanings and the usage of a particular word.  

There are three buttons in the Services group, which provide the following additional possibilities:  

After pressing the upper part of the Pronounce split button you will hear the synthesized pronunciation of the 
query word or phrase through the computer sound system (headphones or speakers). By pressing the dropdown 
arrow on this button you will invoke a menu where you can choose between the synthesized and natural (human) 
pronunciation:  

If you will press the menu button Windows TTS – you will hear the synthesized pronunciation (Windows TTS 
stands for Windows text to speech);  

If you will press the menu button Natural human voice – you will be directed to the website, where you will be able 
to hear the human pronunciation of the query word (an active Internet connection is necessary in order to use this 
feature).  

A press on the Keyboard  button presents a separate window with an on-screen virtual keyboard. 
On the virtual keyboard you can use your mouse to type in any text, English or Lithuanian. The typed text is shown 
simultaneously in the entry field of the virtual keyboard and in the Search field of the main window. The word typed 
in the entry field is translated in the main window if the Enter key is clicked or in the single click translation (VVV) 

window if  the key is clicked. 

 

In the Repetition group there are two buttons with arrows pointing to opposite directions. By pressing these buttons 
you can once again view the same dictionary articles that you have been browsing during current work session. 
The sequence of viewed articles is recorded and perpetually updated. By pressing a button you move through the 



records, if an arrow on a button point to the left, you move to an earlier record, if it points to the right, you move to a 
later one.  

By pressing the Back  button you can view in the Article pane an earlier entry (than currently shown entry) of 
the recorded sequence.  

By pressing the Next  button you can view in the Article pane a later entry (than currently shown entry) of the 
recorded sequence.  

 

 

The commands of the Editing tab  

The Editing tab contains two command groups: User articles and History records.  

 

The User articles group contains the command buttons which are used to manage records in the user dictionaries. 
These three command buttons manage the records of the open (i. e. active) user dictionary.  

The Add  button opens an editing window where a new article of the user dictionary can be created.  

The Edit   button is active only if the My words tab is selected in the List pane, and the headword of the article 
to be edited is selected in the list. The button opens an editing window where you can edit the selected article of 
the active user dictionary.  

The Delete  button  is active only if the My words tab is selected in the List pane. By pressing the button you 
will get a menu, where you can choose the way the records will be deleted:  

 

The Delete selected record button deletes the user dictionary articles (the records of the user dictionary) the 
headwords of which are selected by you in the list of the My words tab. The Delete all records button deletes all 
articles of the open (active) user dictionary, making it empty.  

  The History records group contains the command buttons which are used to manage the records in the history 
list. The history list consists of the headwords of the articles that have been viewed in the past, and the entries of 
the history list were collected chronologically.  

The Collect  button switches on or off the capability to collect (accumulate) in the list all the headwords of the 
articles that have been viewed in the past. You can achieve the same with the collecting/not collecting toggle 
button in the Status bar at the bottom of the window.  

The Copy  button  is active only if the History tab is selected in the List pane, and one or more entries are 
selected in the history list. The selected entries are copied to the clipboard.  

The Erase button  is active only if the History tab is selected in the List pane. By pressing the button you will 
get a menu, where you can choose the way the records will be deleted:  



   

The Erase selected records button deletes only selected entries (records) of the history list, while the Clear all list 
deletes all records in the history list making it empty.  

 
 

The commands of the View tab  

  

There are five groups in the View tab: Window, Panes, Užrašai/Captions, Style and Control, containing the 
commands (controls), which are used to change the settings of the window.  

There are two command buttons in the Widow group, which can change the status of the main window of the 
program:  

By pressing the Always on top  button you can allow the main window of the program to stay on top of all 
other windows even when it does not have focus. The button is duplicated in the Status bar at the bottom of the 
window;  

By pressing the Compact   button you can minimize the Ribbon, in this case the buttons and command 
groups stay hidden. The button is also duplicated in the Status bar at the bottom of the window.  

The Panes group contains the following command buttons:  

The Lists visible   button is used to hide or show the List pane;  

The History  button is used to hide or show the history lists in the List pane. If history lists are hidden, 
there is no History tab in the List pane;  

The Words visible  button is used to hide or show the headword lists of the user dictionary in the 
List pane;  

The Swap panes  button swaps the Article and List panes – the pane at the right side of the main window 
goes to the left side, and the pane at the left size goes to the right.  

The Užrašai/Captions group contains the following command buttons :  

The Lietuviškai  button is used to switch the language of the user interface to Lithuanian;  

The English   button is used to switch the language of the user interface to English.  

In the Style group you can choose the colour styling of the program's windows:  



 

The Control group contains the Settings  button, which is used to invoke the Program's settings window in 
which you can change the parameters of the program.  

 

The commands of the Help tab  

The Help tab includes the following groups: Help, Update and Help online.  

 

The Help group has two buttons:  

The About button  opens an information window displaying the current version number of the software as well 
as other data .  

 

The How to use?  button opens a window displaying the description of the program.  



 

The Update program  button of the Update group checks if updates of the program are available on the 
Internet.  

 

The sole button of the Help online group can link to the website of UAB „Fotonija“ (the independent software 
vendor).  

 

The Search field  

The text (word or phrase) must be entered into this field. The search engine tries to find the translation or 
explanation of this word or phrase (called respectively the query word and query phrase throughout this 
documentation) in the dictionaries of this program.  

 

The button on the left side of the field starts a new search based on the query word or query phrase currently 
present in the field. Also, a new list of findings is generated.  

The button switches on the text entry prompter. While entering the text in the search field in this mode you can 
see the changing list of available dictionary headwords in the list pane, so you are prompted to choose an item 
most suitable for translation from that list.  

The dropdown arrow on the right side of the field displays a context menu with a list of query words and 
phrases, the search of each list entry in the past was started by pressing the ENTER key on a keyboard. At the 
start of the program this list is empty. If the search starts automatically or without involvement of the ENTER key of 
the keyboard, the query word or phrase is not added to the list. The list is filled until the program is closed, but it is 
not saved. The list is in fact a volatile history of user's voluntary searches. Do not confound it with the history lists 
displayed under the History tab – these later are the permanent lists of headwords of the dictionary articles which 
were viewed by the user in the past.  

By pressing the broom butt on on the extreme right of the field you will erase all the text in the field, making it 
ready for entering a new text.  

You can enter a text into the Search field by various methods:  

• by typing with the computer keyboard or by pressing the keys of the on-screen keyboard;  

• by pasting it from the clipboard;  

• by automatically loading the text, that is copied to the clipboard (to achieve this you must mark the 
Translate the clipboard check box in the Program's settings window, the Main settings theme, the Clipboard and 
text selection monitoring group);  



• by double-clicking a list entry under the Findings, My words or History tab;  

• by selecting an item in a context menu that is displayed by pressing the dropdown arrow on the right side 
of the Search field (the search starts automatically);  

• by opening the main window from the single click translation (VVV) window;  

• by selecting a word in the Article pane and choosing the mode of search from the context menu which is 
displayed by right-clicking the selected word:  

 

 
 

The List pane  

There are three tabs in the List pane: Findings, My words and History. Each tab displays a corresponding list. The 
form and content of lists varies. After clicking on an entry in the list you will see a  related dictionary article. You can 
change the position of the pane (on the right or left side of the window) by pressing the Swap panes button (in the 
Panes group of the View tab). Also, you can hide (or expose) this pane by pressing the Lists visible button (in the 
Panes group of the View tab).  

The search results are shown in a list which is assigned to the Findings tab. The form of the lists belonging to this 
tab varies because it depends on the search type.  



The Words search button generates a list (the size of the list can be limited by changing settings in the Search 
theme of the Program's settings window), in the centre of which there is a marked line with the search result (word 
or phrase). Above and below of this line the neighbouring words or phrases are added (each on a separate line); 
these neighbours are not the search results, but they can help to grasp the dictionary context. On the right side of 
each line of the list you can see the pictographs denoting different dictionaries. The presence of a particular 
pictograph means, that the dictionary symbolized by that pictograph contains the list entry (a word or phrase on 
that line). E.g., the presence of three pictographs on the right side of the line with the list entry means, that this 
entry (word or phrase) is present in three different dictionaries.  

 

 

The Context search button generates a list ( which is assigned to the Findings tab ) of the phrases containing the 
query word (a word that is entered into the search field). Various forms of the query word are displayed in the 
central column in bold, the rest of the phrase is shown to the left and to the right of the central column thus forming 
a concordance view.  

 

 



The Headwords search button generates a list of dictionary headwords containing the query word, and the list is 
assigned to the Findings tab. Also, o n the right side of each line of the list you can see the pictographs denoting 
the dictionaries where the headwords were found. The pictographs indicate in which dictionary you can find a 
particular headword.  

 

 

The Prefix search button generates a list of dictionary headwords having the same beginning with the query word 
(the query word is in this case a string consisting of the first letters of a particular word you are searching for). The 
list is assigned to the Findings tab. The pictographs o n the right side of the list indicate in which dictionary you can 
find a particular headword.  

   

 



The Similarity search button generates a list of dictionary headwords which sound similarly with the query word. 
The list is assigned to the Findings tab. The pictographs o n the right side of the list indicate in which dictionary you 
can find a particular similarly sounding headword.  

 

 

By clicking on the My words tab you can display the list of the active user dictionary headwords. You can hide or 
display the tab by pressing on the My words button in the Panes group of the View tab. If the tab is hidden then you 
can not display the list of user dictionary headwords. You can make any of the user dictionaries active by opening it 
(in a menu, which appears after clicking on the application button at the top left of the main window).  

 

 



By clicking on the History tab you can display the list of headwords of dictionary articles that had been viewed for 
some time (the time interval, which must pass before the headword is included into the history list, it can be 
changed in the Settings window, the History list theme). You can hide or display the tab by pressing on the History 
button in the Panes group of the View tab. If the tab is hidden then you can not display the history list. After clicking 
on a list entry you will see the corresponding dictionary article.  

 

 

By right-clicking on the My words tab panel, you will get a context menu where you can manage the user dictionary 
files or separate articles.  

 

 



By right-clicking on the History tab panel, you will get a context menu where you can manage the history files and 
records. 

 

 

A right-click in the Findings tab will invoke a context menu which enables to repeat the search or to show/hide the 
list scrolling arrows.  

  

 

 



The Article pane 

The articles of the dictionaries of this program are presented in this pane. 

The articles are presented in this pane after each search or if a new list entry is selected in the List pane. The pane 
contains three tabs each representing a different dictionary of the program. After pressing a tab you will get an 
article (the headword of which is defined by the search results, or by newly selected list entry in the List pane) from 
the dictionary, associated with that tab. If a different tab is pressed, you will get an article with the same headword 
but from different dictionary. 

If a dictionary does not contain an article with some headword (produced by the search or retrieved from the list), 
the tab of that dictionary is inactive. There are the following tabs in the Article pane:  

 

the Main translation tab, 

 

the Thesaurus tab, 



 

the My translation tab. 

The colour of the tab informs if the associated dictionary contains the article with the query word. 

        Bright, if the dictionary article is already presented in the pane;  
        Accentuated, if the associated dictionary contains the article that can be opened after pressing on that tab; 
        Pale with obscure lettering - if the associated dictionary does not contain the article, the tab is inactive. 

 

If you select and right click a word in the Article pane you will get a context menu where it is possible to do the 
following actions: to copy the word to the clipboard, to hear the pronunciation of it, or choose between five modes 
of search using the selected word as a query word.  

 

 



By right-clicking anywhere within the Article pane, you will get a context menu where it is possible to copy the 
whole article to the clipboard or choose one of the suggested printing modes.  

 

 

The Status bar 

At the bottom of the application window is the Status bar. The bar contains convenient controls for quickly changing 
the status and view of the application. Also, auxiliary information is presented there.  

 

The left side of the Status bar contains the status items. The right side (shown in darker colours) contains the items 
which can change the view of the application window. 

You can switch on/off the translation of the text copied to the clipboard by clicking the  icon. The label beside 
the icon indicates the current status of the application. The translating label shows that any text copied to the 
clipboard will also appear in the search field and will be automatically translated, whereas the not translating label 
means that no translation occurs if text is copied to the clipboard.  The clicking on the icon or on the nearby label 
toggles the status to the opposite one. 

The icon and the accompanying label show if the history (the list of viewed dictionary articles) is being 
collected. The collecting label means that the headwords of the viewed articles are added to the history list 
whereas the not collecting label means that no new data are added to the history list. The clicking on the icon or on 
the nearby label toggles the history accumulation status to the opposite one. 

The middle of the Status bar is used to display information which is search related: the progress bar, the number of 
articles found, the duration of search, the length of the findings list, etc.  

On the right side of the Status bar there are buttons which can change the view of the application window. The 
on/off status is indicated by the brightness of the background colour around the button. The bright colour indicates 
the on status. The colour of the background depends on the skin chosen.  

The button  Always on top toggles the application window between the normal mode and the always-on-top 
mode. 

The button  Compact toggles the application window between the normal mode and the compact mode which 
emphasizes the information found in dictionaries, with most controls hidden (the Ribbon is minimized). 

The button   Show the VVV window (F4), opens the Single click translation (VVV) window, which is shown 
alongside with the main window. Usually it is used instead of the main window.  

 



The Single click translation (VVV) window  

Translations of the words displayed on the computer screen can be given in a separate translation window. This 
compact window pops up automatically if the words under the mouse cursor are being translated using the special 
mode of operation of the program. In most cases it is the most convenient and fastest translation mode because it 
is unnecessary to enter query words using the keyboard or change the direction of translation - this is done 
automatically. Moreover, in this case the program analyzes the context (surrounding words) of a word being 
translated, and automatically selects the most appropriate translations to be shown in the VVV window. In the 
program you can choose the events after which the translation is given in this window. The translation is given: 
after 3 seconds if the mouse cursor rests unmoved over a word; or the text is copied into the clipboard; or a 
predefined combination of a keyboard key and mouse button (which is defined in the window Settings) is pressed. 
If the text comes from the pictures, then OCR (Optical Character Recognition)starts automatically and extracts the 
text to be translated. In this case the translation is less speedy, sometimes the program is even unable to extract 
the text from certain pictures.  

 

Note: Even texts in pictures can sometimes be translated by this method, you should mark the Use OCR check 
box in the Text recognition group of the Other settings theme in the Program's settings window. Sometimes the 
screen reading can be blocked by some programs - then use the clipboard to pick up information. Even the copying 
to the clipboard is not allowed by some programs - in this case select the text and press the key combination 
Ctrl+Shift+T on the keyboard (you should mark the Translate the selected text check box, in the Start of translation 
group of the Single click translation theme in the Program's settings window) or simply enter the text from the 
keyboard in the main window to get the translation.  

The flag  or  shows the active direction of translation (an active flag denotes the source language). The 

button with the arrow opens an entry field. There you must type a word that will be used by the search engine 
(after pressing the ENTER key on the keyboard) to find relevant entries in the dictionaries of this program. Below is 
a button to change the direction of translation. 

 

If the current direction of translation is not suitable, you can choose another direction after clicking the triangular 
arrow on the upper left corner of the VVV window.  

The text area of the VVV window can contain the internal hyperlinks providing more extensive information about 
possible translations. You can modify the appearance of the VVV window by making changes in the Program's 

settings window or using buttons as well as menu (activated by right clicking the text area ) inside the VVV 
window.  



You can return to the main window by pressing the button Show the program's main window.  

By pressing the button  Automatic translation after 3 seconds you will switch on the continual translation 
mode, which tracks the mouse movement - if the mouse stops for more than 3 seconds, the word under the mouse 
cursor is automatically translated.  

The size of the VVV window, font size position on the screen and mode of closure can be modified using the 
commands of the drop-down menu, which appears after right clicking the text area of the VVV window.  

 

The amount of information presented in the VVV window can be controlled in the drop-down menu which appears 

after clicking on the button . 

 

I n the Single click translation theme of the Program's settings window a user can establish the most convenient 
mouse button/key combination (hot combination) to invoke the translation.  

 

Controls of the VVV window  

The same direction of translation is used in both the VVV window and the main window. If the direction of 
translation is not appropriate (i. e. the language of the text you are clicking on differs from the language you are 
currently translating from - the source language - indicated by a small national flag on the upper left corner of the 
VVV window), you will not get a correct translation in the VVV window. The direction of translation can be changed 
inside the VVV window. On pressing the dropdown arrow near the flag (which symbolizes the source language) the 
Search in dictionary menu appears. You can change the direction of translation (the source language) in the menu.  



 

By right clicking anywhere in the translation area of the VVV window you will invoke the menu in which you can 
change the appearance of the window.  

The button  Small window sets the minimal size of the VVV window (300x160).  

The button  Normal window sets the medium size of the VVV window  (360x200).  

The button  Large window sets the maximum size of the VVV window  (416x248).  

The button  Small fonts sets the small fonts in the VVV window.  

The button  Normal fonts sets the medium fonts in the VVV window.  

The button  Large fonts sets the large fonts in the VVV window.  

The button  Remember the fixed position invokes the VVV window in the same position as it was last time 
positioned by the user.  

The button  Near mouse or text cursor  defines that the VVV window will appear near the mouse or text 
cursor.  

The button  Automatic closure defines that the VVV window will close automatically after some predefined 
time (which can be changed in the Settings window).  

The button  Manual closure defines that the user himself must manually close the VVV window.  

The button  Keyboard  presents a separate window with an on-screen virtual keyboard. 

The vertically arranged buttons on the right side of the VVV window perform the following functions:  

               Open the Settings window to change the parameters of the program  

               Show the main window  

              Switch on/off the continual translation mode, which automatically translates the word under the 
mouse cursor if mouse is not moved for more than 3 seconds.  



  

               Display a menu, in which you can choose the sources of information forming the VVV window:  

             Show or hide the main dictionary information.  

             Show or hide thesaurus information (the button is visible only when translating from English).  

            Show or hide user dictionary information.  

             Show or hide main dictionary phrases.  

             Internet translation (active only after the plug-in is installed; it is visible only when translating from 
English ).  

    Pronounce the clicked word, which invoked the VVV window ( only when translating from English ).  

 

The structure of the dictionary article in the VVV window  

The text in the VVV window consists of individual segments which are marked by pictographs indicating source and 
character of information displayed. The display of information from each individual source can be switched on or off 
using the buttons of the drop-down menu which can be invoked on the right side of the VVV window.  

   

The pictographs used in the VVV window have the following meanings:  

                      translation of a word was not found, but there is a reference to another word (e.g.: corpora see 
corpus),  

                      no translation found in any dictionary,  

                       article(s) found in Piesarskas dictionary,  



                  lexical homonyms found in the dictionary, they are marked by indices 1 - 6,  

                       translation of the phrase containing the query word was found in the dictionary; the references 
(hyperlinks) to other phrases containing the query word can be presented below,  

                       article(s) found in the English thesaurus. The definitions, found in the English thesaurus, are 
labeled with pictographs, denoting the following parts of speech:  

                             noun,  

                             adjective,  

                             verb,  

                             modal or functional verb,  

                             adverb,  

                             pronoun,  

                             preposition,  

                             particle or suffix,  

                             participle, 

                             numeral,  

                             conjunction,  

                             prefix,  

                             interjection,  

                             article ,  

                             gerund,  

                             abbreviation,  

                             punctuation mark,  

                             unknown or unsorted part of speech,  

                      article(s) found in the user dictionary ,  

                      a fragment of a text line found under the mouse cursor at the moment of a mouse click,  

                      notification about disabled functions of the VVV window,  

                       the translation uses the public machine translation service on the Internet,  

                       machine translation of a text ,  

                       error of the machine translation server or the server is inaccessible,  

                       the machine translation server is inaccessible.  

 

 



Settings of the program  

In the settings window you can modify the functionality and appearance of the program.  

The Program's settings window can be opened in several ways:  

• By pressing the Ctrl+O key combination on a keyboard;  

• By pressing the Settings button in a menu which can be opened by clicking the Application button;  

• By pressing the Settings button in the Control group of the View tab;  

• By the dialog box launcher (marked by arrow, see the figure), which is present in the Search group of the 
Home tab; 

 

• By Settings button in the VVV window;  

• By the Program's settings (Ctrl+O) command in the quick access toolbar.  

 

It depends on the user whether this command is included in the Quick Access toolbar (the command can be 
included or excluded in the menu of the Quick Access toolbar, it is included in the toolbar by default).  

In the settings window you can change the settings one-by-one or several at a time as well as choose between 
several sets of settings predefined by the software vendor. You can choose between two predefined sets of 
settings in the All settings menu, at the bottom of the window. The chosen set becomes the active set, i. e. it 
modifies the functionality and appearance of the program.  

 

The Default set contains the parameters which are used right after the installation procedure. The Classic set 
modifies the appearance of the main window in order to retain similarity with the first version of the Anglonas 
dictionary. If any of the settings  in the Default or Classic set is changed, then the current set is automatically 
copied to the Custom set, which becomes the active set. Further changes can be made to this set. The set is 
retained if you save it with the Save button. 

 

The Main settings theme  

The Main settings theme contains the parameters which regulates the language of the captions used in the user 
interface of this program as well as parameters regulating the general features of operation. By marking a check 
box you will enable the program feature which is shortly described in the caption (label) beside that check box.  



 

In the Language of captions group you can choose the language of captions (labels) used in the windows of this 
program as well as in most help files:  

If you will select the menu item Lietuvių – all captions will be in Lithuanian;  

If you will select the menu item English – all captions will be in English.  

In the Operation features group you can find and change some general features of operation of the program. The 
check boxes in this group perform the following functions:  

Auto-start with the operating system - the program will start automatically after loading the Windows operating 
system;  

Show the icon in the system tray if the program is minimized  – after minimizing the main window of the program its 
icon appears in the System Tray (i. e. in the System Notification Area, which is at the bottom right of the screen, at 
the extreme right of the task bar);  

Use sounds when a new article is shown – you will hear the sound signal each time a new article is shown in the 
Article pane;  

Remember position and size of the main window – at the start of the program the main window will be in the same 
position and of the same size it was at the last time it was closed;  

Show a progress window on a lengthy search – at the start of the search a separate temporary window with a 
progress bar appears, the window closes automatically at the end of the search;  

Auto-open the last used dictionary – at the start of the program the user dictionary that was used last time will be 
loaded automatically, if the check box is unmarked, the Default user dictionary will be loaded.  

In the Clipboard and text selection monitoring group you can find and change the following features:  

Translate the clipboard – the program automatically moves to the Search field any text copied to the clipboard in 
any program, and performs the search based on the first words of the text;  



Translate the clipboard in the single click translation window – if any text is copied to the clipboard in any program, 
the single click translation (VVV) window will appear;  

Translate the clipboard only if the program's window is the topmost one – the program translates the text copied to 
the clipboard only if the program's main window is in always-on-top status. 

 

The Appearance theme 

The Appearance theme contains the settings which define the general appearance of the program's windows. You 
can change the appearance of the windows by marking the check boxes, by pressing on radio buttons or by 
selecting available menu items. 

 

In the Skin group from the dropdown menu you can select the colour styling of the program's windows. 

In the Lists, tabs group you can change some basic layout details of the main window: the position of the List and 
Article panes, the position of the tabs or the status of the Ribbon. 

• By marking the Tab labels on bottom check box you will position the tabs of both panes at their bottom. 

• By marking the Hide word lists check box you will hide the List pane, thus only the Article pane will be 
visible and you will have more space for dictionary articles. 

In the Visible lists frame you can define which lists will be visible in the List pane: 

• By marking the Show tab "History" check box you will make visible the history list of viewed articles; 

• By marking the Show tab "My words" check box you <> will make visible the list of the headwords of the 
user dictionary. 

In the Position of lists frame you can define the position of the List pane in the main window of the program: 

• If you press the radio button Left - the List pane will be on the left side of the main window; 

• If you press the radio button Right - the List pane will be on the right side of the main window. 



In the Window state frame you can define the state of the Ribbon in the main window of the program: 

• If you press the Full, large buttons radio button - the Ribbon will be displayed in the main window; 

• If you press the Compact, small buttons radio button - the Ribbon will be in the minimized state, thus you 
will save some space for displaying the dictionary information. 

 

The Single click translation theme 

These settings can change the combination of the key and mouse button which activates the single click translation 
(VVV) window, the way it closes, its appearance and the size of a context used in the process of translation. All 
these settings apply to the operation of the VVV window only.  

 

In the Start of translation group a user can choose the most appropriate key and mouse button combination ("hot 
combination") which will invoke the VVV translation window.  

If a user marks the Translate on a key press check box, the VVV translation window will be invoked by a 
simultaneous press of a special combination of a keyboard key and a mouse button, and the query word under the 
mouse cursor will be translated. The most appropriate key and mouse button combination can be defined by 
marking the keys and buttons in the Key combination table:  

Keyboard :  Mouse button:  

Ctrl Left 

Shift Middle 

Alt Right 



Occasionally, the chosen hot combination of the key/mouse button can coincide with a hot combination used by 
some program to perform an action in the window where the mouse cursor has been moved by a user in order to 
point a word that must be translated (a query word). In such a case the user must choose another hot combination 
to invoke the VVV window.  

Also, a user can additionally choose a special hot key combination to invoke the VVV window without clicking any 
mouse buttons. If a user marks the Translate under the mouse cursor check box, the key combination Ctrl+Shift+M  
will invoke the VVV window and the query word under the mouse cursor will be translated. If a user marks the 
Translate under the text cursor check box, the key combination Ctrl+Shift+C  will invoke the VVV window and the 
query word under the text cursor will be translated.  

In the Presentation of the single click translation window group a user can set or choose the parameters which 
influence the display of the VVV window.  

If the Auto-close the s. c. translation after check-box is marked, the VVV window hides automatically after being 
displayed for a time interval which is defined by the user by editing a value in the spin box. A hiding delay can be 
set from 1 to 20 seconds by pressing the arrows in the spin box  or writing directly there.  

By pressing the radio buttons within the Position on the screen frame , a user can define the location on the screen 
where the VVV window will appear.  

If t he Near mouse or text cursor radio button is pressed, then, on activation, the VVV window will appear near the 
place where the cursor was at the moment of activation of this window.  

If t he Remember the position on the screen radio button is pressed, then, on activation, the VVV window will 
appear in the same place where the VVV window was closed last time.  

You can choose one of the three possible sizes of the VVV window in the Window size drop-down menu:  

• Small window  

• Normal window  

• Large window  

  In the VVV window the text is displayed using one of the three possible font sizes - you can choose one in the 
Text size drop-down menu:  

• Small fonts  

• Normal fonts  

• Large fonts  

The extent of the context used in the process of translation can be defined in the Context analysis group.  

If the Take several context words for better translation check-box is marked, then preference is given to the 
translations best matching the context – they are placed at the start of the queue which contains the translations 
found in the dictionary.  

The result of context analysis depends on what number of neighbouring words is taken into account. The number 
of words taken into account  before and after the query word are defined separately in corresponding spin boxes:  

before word: an optional number from 1 to 20, it can be changed by pressing the arrows in the spin bow  or writing 
directly there.  

after word: an optional number from 1 to 20, it can be changed by pressing the arrows in the spin bow  or writing 
directly there.  

  Note. The greater the number of words before and after the query word, the longer it takes to perform the analysis 
of the context and to translate accordingly.  

 

The History list theme 

The History list theme contains the settings which define the accumulation, recording and presentation of the 
dictionary articles viewed in the past. Here you can change the program's parameters by marking the check boxes 
or by changing the numerical values in the fields. 



 

In the Collection of history group you can enable the accumulation (collection) of viewed articles by marking the 
Keep collecting the history check box. If the check box is marked, the headword of the dictionary article is added to 
the history list only if it was viewed for a sufficiently long time (you can change the duration of that delay in the New 
record group of this window). 

In the New record group you can define for how long the dictionary article must be viewed before it is added to the 
history list. In order to change the duration of delay you must change the numerical value (in seconds) in the field 
below the label Write a new history record after an article was shown for: 

You can enter a number in the range from 3 to 30 by typing or by using the arrows of the field. 

In the Amount of records group you can define the maximum number of records in the history list. In order to define 
that number you must enter it in the field beside the label Maximum number of history records: 

You can enter a number in the range from 40 to 2400 by typing, by using the arrows of the field or by moving the 
slider on the track bar below. 

 



The Search theme  

The settings which determine the search of translations and display of search results are grouped into the Search 
theme. The checked box or number in a field determines the corresponding parameter of the search.  

 

In the Execution of search group you can set a time lag between the moment when the last letter was entered into 
the input field (or the text was copied into it) and the automatic start of the search. If the  Start searching if no text 
entered the input field for check box is not marked, the search will start only after pressing of the ENTER key. If you 
will check the box, then you can enter the numerical value of the time lag:  

<< 2,0 sek.  >> – choose or enter a number from 2 to 15, which sets the time lag in seconds.  

In the Neighbouring words group you can set a number of neighbouring headwords from the main dictionary, which 
will be shown in the Findings pane above and below of the headword found by the search engine. The 
neighbouring words can help to better understand the context of the dictionary entries. You can define the number 
of neighbouring words by entering a numerical value in the field below the label Add the headwords of 
neighbouring articles to the list of findings:  

<<  21  >> – choose or enter a number from  0 to 50, which sets the number of words to be shown.  

In the Extent search group you can define whether additional algorithms for the search of the context will be used. 
Also, there you can set a limit on the number of search results that will be shown. If the Use additional algorithms 
for the search of the context check box is checked, you will get more numerous and more exact results at the cost 
of a lengthier search. You can define the number of words used by the search engine by entering a numerical 
value in the field below the label Maximum number of words used for the search:  

<<  5  >> – choose or enter a number from 1 to 6, which sets the number of words used by the search engine.  

Sometimes the search outputs a very long list of findings. You can limit the number of output results by checking 
the Limit the number of output results by check box, and then choosing or entering a number from 20 to 800 in a 
nearby field (also, the number can be set by moving the slider on the track bar below). 

 



The Other settings theme 

In the Other settings theme you can activate the English-Lithuanian Internet machine translation, the results of 
which then can be displayed in the VVV window. The translation is performed using the public online translation 
service provided by Vytautas Magnus university. 

 

In order to use the Internet machine translation you first must download and install the necessary plug-in from the 
Vytautas Magnus university website. After installation of the plug-in you must mark the Use an online Internet 
machine translation service check box. An active Internet connection is needed to use this feature. You can send a 
sentence (containing the clicked word) or a whole paragraph for translation - you can regulate this by two radio 
buttons in this window. Also, you can check if the service is working by pressing the Check service button in this 
window. 

You can opt for an automatic change of the keyboard layout according to the direction of translation. If this feature 
is enabled , you will always get the right keyboard layout for entering text in the Search field. To get this feature, 
you must mark the Change keyboard layout on translation direction change check box in a Synchronize keyboard 
layouts group. In this case the onscreen keyboard is also synchronized with the computer keyboard - all keyboards 
will change their layout simultaneously. 

You can enable the optical character recognition (OCR) feature in the Text recognition group. This feature is being 
used for the screen text capture in the VVV window. The feature is helpful if the regular text recognition mode 
(which is fast and accurate) fails in the VVV window. The regular mode does not work in pictures as well as in 
some programs. If you will mark the Use OCR check box, the OCR engine will switch on additionally in cases, 
when the regular character recognition mode yields no results. Please note, that the OCR engine is not as accurate 
as the regular mode. 

 



The user dictionaries 

Users can make their own dictionaries, use dictionaries of other users or import their dictionary data. 

Two kinds of actions on the user dictionaries are possible: 

Working with the user dictionary files; 

Working with the user dictionary articles.  

 

Management of the user dictionaries 

 The user dictionaries can be managed in the application menu, which is invoked by pressing the Application button 
in the upper-left corner of the main window. 

 

   In order to create a new dictionary the New  button must be pressed - it will open a window where a new 
dictionary file can be created. 

 

You must enter a desirable  name of the dictionary in the field File name and  save it by pressing the Save button. 
An empty file is created as a result of these actions. Later you can fill the file by using various commands grouped 
under the Editing tab in the main window.  



You can choose any available user dictionary after pressing the Open  split button. Pressing on the left 
segment of the split button invokes the window where you can  select a user dictionary. After selecting a desirable 
user dictionary, you can make it active (i. e. viewable, editable and seamlessly attached to the search engine) by 
pressing the Open button on this invoked window. Sometimes a more easy way to make a user dictionary active is 

to press the right side of the Open  split button (the arrow), then use the most suitable menu item - Select, 
Last used or Default. By pressing the Select menu item you will invoke the same window as if pressing the left 

segment of the Open  split button. By pressing the Last used menu item you will activate the user dictionary 
that had been used before the default user dictionary was made active. By pressing the Default menu item you will 
activate the default user dictionary, which is supplied by the software vendor along with the main dictionary. The 
Default dictionary can be edited, however, you can not delete it. 

By pressing the Select button it is possible to choose and open any available user dictionary. 

Pressing the Default button opens the Default user dictionary. 

Pressing the Last used button opens again the user dictionary which had been active before the default 
dictionary was opened. 

Pressing the Import  button starts the import from another dictionary, and new records are added to the active 
user dictionary; in the course of the import the following sequence of notifying windows is presented, and you 
should do the following actions: 

  

1.    Start the import, 



 

2.    Select the dictionary to be imported, 

 

3.    Wait while the procedure is performed, 

 

 4.    See the results. 

By pressing the Save as button you can save the active user dictionary after specifying a new file name and 
location where you want to save the dictionary. 

 

Building and editing the user dictionaries 

The commands operating on the user dictionary articles or history lists of viewed words are grouped under the 
Editing tab. 



 

This tab includes the User articles group containing the controls destined to work with the articles of an active (i. e. 
opened) user dictionary. The another group - History records group - contains the controls for maintenance of the 
history lists of viewed words and is thoroughly described in other section. 

In order to add a new word to the active user dictionary, the Writing the dictionary article window must be opened. 
This window is invoked  by selecting the Editing tab and then pressing the Add  (the Add button is used to create a 
new article) or Edit button (the Edit button is used to edit the already existing user article) in the User articles group. 
Both buttons invoke the same window. You must edit the appropriate fields or fill them with translations, comments, 
etc. 

 

In order to write a new dictionary article the following actions should be taken: 

1.                         You must write down the headword (lemma) of the dictionary article in the Headword field; 

2.                         Write down the phonetic transcription in the Pronunciation field. The International Phonetic 
Alphabet (IPA) symbols are accessible in a drop-down field (menu), which is activated by pressing the dropdown 
arrow on the right of the Pronunciation symbol control. A special pronunciation symbol can be entered to the 
Pronunciation field by pressing the necessary IPA symbol in the drop-down field. The symbol appears in the 
Pronunciation field to the right of the text cursor. The last entered symbol also appears on the left field of the 
Pronunciation symbol control. By pressing that field you can enter the depicted symbol to the Pronunciation field, to 
the right of the text cursor. 



 

3.                         In the General label field a user can write down a (semantic, stylistic, etc.) label or choose a 
predefined (standard) one from the drop-down menu. 

4.                         You can choose an appropriate part of speech (POS) from the Select POS menu. 

 

For each different POS chosen (noun, verb, adjective and adverb) by pressing a "plus" tab, a separate table 
appears. It is used to translate one meaning of the headword. The translation may consist of one entry (one row in 
a table) or a group of entries, consisting of synonyms or semantically related words (a group of rows in a table). All 
data entered in the table (labels, translations, comments) must be relevant only to one meaning of the POS. You 
can change the sequence of tabs by the arrows of a control given below: 

 

A selected POS tab can be deleted by pressing the Delete button on this control.  

5.                         Three fields of a row are dedicated to enter the translation of a particular meaning of the 
headword. In the Label field a user can write down a (semantic, stylistic, etc.) label or choose a predefined 
(standard) one from the drop-down menu. In the Translation field the temporary text ..translation here.. must be 
replaced by a relevant Lithuanian translation. Comments if any must be entered in the Comment field. 

6.                        Other translation variants of the same meaning (for the same POS) must be entered in the rows 
below, each variant must occupy a separate row. These rows can be added, arranged or deleted by using the 
following buttons: 

Push upwards moves the selected row up by one position 

Push downwards moves the selected row down by one position 

Insert above adds a new row above the selected one 

Append adds a new row below the selected one 

Delete removes the selected row 

7.                         If the headword has several meanings (for one POS), a new table must be presented in order to 
enter an appropriate group of translations of that meaning. The new groups can be added, sorted or controlled by 
pressing the following buttons: 

Push upwards moves the selected group up by one position (the whole group is selected if any item of it is 
selected) 

Push downwards moves the selected group down by one position 



Insert above adds a new group above the selected one 

Append adds a new group below the selected one 

Delete removes the selectid group 

A serial number is automatically incremented and assigned to each meaning, thus translations of different 
meanings appear sequentially numbered in the user dictionary. 

8.                         A headword can represent several parts of speech. The editing window starts with one tab 
defined for one POS. A new tab for another POS can be created by pressing the tab with a plus sign. You must 
choose an appropriate POS for a newly created tab and fill in the relevant fields as described above. 

9.                        While filling the form on the left side of the editing window, on the right side of it you can view the 
current status of the article - exactly as it would appear in the user dictionary. 

10.                     After making sure, that the article is accomplished you can add it to the currently active (opened) 
user dictionary by pressing the Save button. By pressing the Save, add new button you add your newly created 
article to the active user dictionary and open a blank form to create another article. By pressing Cancel you can 
delete your newly created article (or cancel all changes made to an old (already existing in the active user 
dictionary) article if you have been editing it after opening with the Edit button). 

P.S. 
You can add an unknown word to the user dictionary directly from the single click translation (VVV) window.  

  

If no translation is found in the course of search, an icon appears in the VVV window along with the following 
notation: Add new article. By clicking the notation Add new article you will open a new window where you will be 
able to create a new user dictionary entry.  
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